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You know you're supposed to back up your data, but if you're not sure how to get started, this 
guide will help. 

We all know we're supposed to back up our data. We could go so far as to say that a backup 
of digital data is essential to a person's well-being and peace of mind. (One copy of a file on 
your computer does not a backup make. Redundancy, people, redundancy.)

Why, then, do so many people still not bother to back up? Even after losing an important 
document, irreplaceable photo, or entire sets of financial records, some still don't take the 
time. Perhaps it's because backing up takes some effort. In the past, it's been complicated. 
Now, thanks to new software, hardware, and services, it's easier than ever. Here's a quick 
look at the types of backup available, as well as the tools you'll need to pull it off, with as little 
work as possible.

What to Back Up (In Addition to The Obvious)

It might seem like enough to point your backup software to your documents, pictures, videos, 
and music folders and let it do its thing. Maybe it is, if you're diligent about putting your data in 
the right place on your drives. Even so, there are other types of data you should think about 
backing up.
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Email
It's unlikely that your email client software—if you're still using that instead of a 

Web-based system like Gmail or Outlook.com—places your email data files in a convenient 
place for backup. So it's up to you to seek them out and back them up.

Users of Outlook (the software that comes with Microsoft Office) have to keep track of a file 
called the PST (Personal Storage Table), which could be in a couple of different places, 
depending on which version of Outlook and Windows you are running. To find it, open 
Outlook, go to the File tab, select Account Settings on the right, then click it. Go to the Data 
Files tab, click any entry, and Open Folder Location. You also need to make sure that you can
See Hidden Items—in Windows 10 File Explorer, go to the View menu and there's a checkbox 
to make sure.

You can back up the PST manually, of course, but since it can get big, that's not always easy. 
Outlook has an Import and Export option that helps. There's also an Outlook 2007/2003/2002 
add-in from Microsoft called Personal Folders Backup that does just what it says. Follow 
these instructions from Microsoft to use it in Outlook 2010. Or, for simplicity's sake, go with a 
third-party backup tool like Safe PST Backup.

If you're using a different desktop email like Thunderbird, your email isn't in one single file; it's 
spread across many .EML files in mailbox folders. Luckily, Thunderbird supports plug-ins that 
can be used to help.

If you do use a Web-based email, you could also use desktop software like eM Client to get 
access to them, all while in discrete desktop software, which lets you actually back up the 
messages on those services. It supports Gmail, Google Apps, iCloud, Outlook.com, and 
others. The software has its own backup settings under Tools > Settings > Backup, to create a
folder for you regular backup software to check regularly.

Browsers
Why back up your window to the Web? You've carefully cultivated bookmarks or favorites: 
that's reason enough. But let's not forget all those passwords and delicious cookies that make 
access to sites easier. You don't want to lose them in a crash.

Mozilla has backup and sync with encryption built into the Firefox browser. Access it from the 
hamburger menu (the three stacked lines in the upper right), set up an account, and then set it
up on all your Firefox-enabled computers and also Firefox for Android or iOS.

Google Chrome has a similar sync feature, which saves browser settings (bookmarks, 
extensions, themes, even apps) to your Google account if you desire; changes are synced 
whenever you use that account with Chrome on other computers.

But who only uses one browser? Xmarks is a popular way to sync browser data across 
multiple browsers, including Firefox, Chrome, Internet Explorer, and Safari. It can ensure the 
same (or at least similar) browsing experience no matter what browser you're using. Make a 
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single change and it's backed up to the Xmarks servers then added to your other browsers 
when opened.

Drivers
If you've got peripherals, you've got drivers—the software that makes your computer talk to 
video cards, printers, scanners, and the like. Simple Windows software apps 
like DriverMax (which installs extra toolbars, so watch it during install) or SlimDrivers will back 
up your current drivers and also search out current versions of drivers that are out of date. If 
you neglect backing up these handy files, you might have to rummage through every 
manufacturers' website to get them when you're performing a restore—but to be honest, that 
might be the better way to go, so you have the most up-to-date drivers all digitally signed. It 
will take more time, but might benefit you in the long run.

Social Networks
It may seem weird to back up info that you don't keep on your hard drive, but do you seriously 
trust Twitter and Facebook to never, ever suffer a catastrophic data loss? Be prepared. It's not
like you'd use these backups to restore them to online use in most cases, but better to have a 
redundant copy for your records than risk losing it all.

For Twitter, you don't need a third-party tool anymore. Sign in via the desktop browser and go 
direct to your account settings. Scroll down and click "Request your archive." You'll be 
emailed a link with the full file of all your tweets and pics you've uploaded in a short time.

On Facebook, go into General Account Settings when logged in on the desktop, and you'll see
a link at the bottom: "Download a copy of your Facebook data." It's the same deal: Facebook 
starts creating an archive then emails you a link for downloading it when ready. You'll get all 
you've ever posted, plus some of your friends' names and emails (if they share them). You 
do not get friends' status updates and photos, even if you're tagged in them, nor your pithy 
comments made on other people's posts.

On LinkedIn, go to Privacy and Settings—you'll have to confirm your login. Click the Account 
tab at the bottom, then click the link for "Request an archive of your data >>". Again: you'll get 
a link in email. They say it could take up to 24 hours. However, I got one in less than five 
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minutes—but only for an archive of messages, connections, and imported contacts. I had to 
wait a while for a second link to download an archive of activity and account history.

Types of Backup

Backing up can be as simple as copying a file from one spot to another, say from your hard 
drive to a removable USB flash drive. But the arsenal of tools at your disposal is capable of 
doing so much more. What you need for redundancy, security, and access, however, decides 
what kind of backup you should use.

Select Files and Folders
If you only need to back up specific data, use software that will let you pick and choose what 
files you want to save. (Remember, simply moving a file isn't backing up. You need at least 
two copies. Redundancy, folks, redundancy.) Just to be safe, back up entire folders on a 
recurring basis to ensure that newly created or updated files get backed up at a later date.

There's plenty of free software to take care of this for you, including Windows 7's own 
integrated Backup and Restore feature, still available in Windows 8 and 10—you can find it in 
the Control Panel. There's also File History, a newer backup option that came along first in 
Windows 8. It's available from the Control Panel AND the Settings app in Windows 10 (just 
type "settings" into your Cortana search bar then click Update & Security). Each pretty much 
offers recurring copying of files you use to a secondary drive as backup. File History is a lot 
easier to set up, but it's also more limited. Then again, File History will also let you create a full
system image backup—that's a full copy of your entire Windows PC system drive as it exists—
so if you ever have to restore it, it'll be exactly as it was on the day of the backup.

Other software you could consider for straight up drive-to-drive backups in Windows 
10: Bvckup2, SyncBackSE or SyncBackPro, and AOMEI Backupper Standard.

Cloud Storage and File-Synchronization Services
A must for anyone with more than one computer in use, synchronization software makes sure 
you have the same files on all your PCs. They always include a backup of files online, which 
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you can access anywhere, even via smartphone. It's the ultimate in redundancy. Big names in
this area include Dropbox, Microsoft OneDrive, and Google Drive (which earned a full five 
stars in our review, as it goes well beyond just file-sync and storage).

With any of these, make a change to a file and it's automatically sent to all the other PCs 
using the account, even on other operating systems. All of them provide a few gigabytes of 
online storage for free, typically 2GB, but you can get a lot more by paying a yearly fee. For a 
comprehensive look at the best available, read The Best Cloud Storage and File-Syncing 
Services for 2016.

Online Backup Services
We're in the era of the cloud, so online backup, once a bit specialized, is and should be the 
norm for backing up important files. Unlike the above services that also include a file-sync 
option, these products tend to lean toward direct backup to online storage, with easy 
restoration options. You install software on the PC, tell it what files/folders to keep backed up, 
and it does the rest in the background. And because the storage is online, you can typically 
read files via the browser, or restore the files to other systems, as needed. Big names you've 
heard of in this are: iDrive, Carbonite, EMC MozyHome, and CrashPlan. For more, read The 
Best Online Backup Services for 2016.

Full Disk Image
There are several ways to back up a full hard drive. The first, copy all the files from the drive 
to another (larger) drive. This means you get everything, even if you don't need it, but it is 
easy to keep up-to-date and restore select files from it as needed.

Arguably the better way is to make an image of the drive. An image is a replica of all of your 
data—every file and folder, even the programs and system files—taken like a snapshot in time 
of the drive at a given moment. When used for restoration, it overwrites what exists after that 
point in time; the hard drive would revert to the state it was in at the time of backup.

Imaging is an especially perfect way to back up a brand new computer. Then, in a couple of 
years when it starts acting wonky (don't kid yourself, it happens to all computers) you can 
revert the drive back to its original settings. Keep in mind, however, that this is like going back 
to the factory settings—albeit your own—which means the restoration will not include data 
accumulated after the original imaging. Data should be backed up separately. (Yes, you 
should have two sets of backups running. Have I mentioned redundancy yet?)

Your best option is to do a full disk-image backup on a regular basis, with data included, using
software that can read images and selectively pull files for restoration when necessary. You 
will need a very big backup destination drive to pull it off, typically an external hard drive (see 
below for recommendations).

Software options for imaging a drive include the free DriveImage XML or Clonezilla, or high-
end solutions like Paragon Hard Disk Manager (our Editors' Choice), or Acronis True Image 
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2016, or the unique Acronis True Image Cloud, which lets you save an entire disk image 
online.

Backup Destinations

How you back up data may depend on the type of media you use as the destination site. Here 
are some options:

External Hard Drives
It doesn't get much easier than this: Plug a big ol' external storage drive into your PC via USB 
and get started. Of course, drives come in all shapes, sizes, and configurations. A standard 
drive won't cost much, but it won't do anything but sit there and let you do all the work (not that
there's anything wrong with that). Almost all drives today use connectors like USB 3.0 or 
Thunderbolt to get incredibly high speeds.

Perhaps your biggest decision will be whether to go with faster but more expensive solid-state
drives (SSD). Unlike hard disk drives, SSDs have no moving parts and that means fantastic 
performance—which is always a plus when you've got a lot of data to copy. For more, check 
out SSD vs. HDD: What's the Difference?

Among what we consider The 10 Best External Hard Drives of 2016 you'll find the LaCie Little 
Big Disk Thunderbolt 2 (1TB) pictured below, Apricorn Aegis Padlock DT FIPS (4TB), and the 
Seagate Backup Plus Desktop Drive (5TB).

CDs/DVDs/Blu-ray Discs
The old stand-by for backup is to copy your files to a shiny disc. The downsides remain 
capacity and speed. CD-Recordables (CD-Rs) can only hold so much data (around 700MB, 
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maximum)—that's so small it's going to feel like using a floppy disk. A DVD-R is much better at 
4.7GB, but even 8.5GB dual-layer DVD-R discs won't hold your entire music and photo 
collection. Dual-layer Blu-ray discs (BD-Rs) store up to 50GB and the prices have dropped—a 
box of 50 goes for less than $25 these days. However, even at that capacity, backing up to 
discs will feel interminably slow compared with fast hard drives and flash drives. Who wants to
take discs in and out all the time?

The upsides: All disk-based media is cheap. Discs are also super portable. It's a good idea to 
keep a backup of your data off-site, if possible. If a disaster takes out your computers and 
storage, it's likely that your backups are gone as well, but it won't get what's not there. And a 
CD is about as easy as it gets to take with you. Well, next to...

USB Flash Drives
Small USB drives are almost as inexpensive as discs, even as their capacity increases. They 
also have the advantage of being uber-portable. Maybe too portable, since they're easy to 
lose (and steal). But locking one multi-GB flash drive in a safe deposit box is easier than 
storing discs or hard drives. Some USB drives are even designed for protection from the 
elements, making them all a safer destination for your data. Of course, you need to get the 
largest capacity drive you can get—generally 64GB—to back up everything, especially if you'll 
be imaging your drive. That can get expensive, but might be worth it for the convenience. Our 
Editors' Choice flash drives with 64GB or higher capacity include the Lexar JumpDrive M10 
Secure, Kingston DataTraveler microDuo 3.0 (right), and SanDisk Extreme 3.0. You can read 
more at The Best USB Flash Drives.

Network Attached Storage (NAS)
A NAS box is a hard drive (or drives) that sits on your network, so all the users on the network 
can access it. Sometimes, a NAS is called a home server. They're not always cheap, and 
some don't even include built-in storage, so you'd have to buy hard drives separately. The 
really cheap ones aren't even going to let you change the storage options. That said, NAS 
boxes are getting easier to work with every day.

NAS can do a lot more than back up a few files. Many can back up multiple computers in a 
home or office. Streaming media from a NAS to a device like a game console or smartphone 
is common place; sharing files across the network and out to the Internet, making it a Web 
server, is also the norm. Most NAS boxes feature FTP, online remote access, security 
controls, and different RAID configurations to determine how drives store your data 
(redundantly or spread across drives). Some even have multiple Ethernet, Wi-Fi, and USB 
ports. Some capture input from networked digital video cameras. The options seem almost 
endless, which makes it worth shopping around to get the right one for your home or office.

Naturally, we've got picks for The 10 Best Network-Attached Storage (NAS) Devices of 2016. 
You can't go wrong with the price or abilities of our top-rated NAS, the Netgear ReadyNAS 
202 (below), which sells for the incredibly low price of $189.99 (though you have to provide all
the drives—it can take up to 12TB). An inexpensive but top rated NAS by PCMag analysts 
remains the Asustor AS-202TE, a $293 device with record-breaking speeds—perfect for your 
multi-PC home backups. If you're going truly high-end, like for an office, consider just about 
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any NAS from Synology—the company is consistently the winner of our Readers' Choice 
Awards for NAS manufacturers.

The Cloud
We kind of covered this above, but it bears repeating, as the cloud seems to be the future of 
backup. The cloud refers to online storage. Sometimes it's used by a service, like Google 
Drive, to store your data. It can also be straightforward storage space provided by big 
companies like Amazon Cloud Drive (5GB free) or small companies like our current Editors' 
Choice favorite, iDrive, which lets you back up multiple devices to 5GB of cloud storage for 
$59.50 a year. It's typically up to you to handle uploading and downloading with minimal 
special tools to help you outside of the service's limited Web interface, though services like 
iDrive (pictured below) are changing that. 

Cloud-based direct PC backup is not new. Mozy and Carbonite have been around for years 
providing direct backup of files on your computer to the Internet, usually in the background 
and in a completely unobtrusive way. There is typically a free tier of service for these kinds of 
services and a subscription fee to back up more (the amount depends on the service).

If you have only a few small files to store, we recommend using Google Docs. You can upload
any kind of file you want to the service, as long as the file is less than 250MB in size. You get 
15GB of free space; the next tier is 100GB for $1.99/month. Adding files or entire folders is as 
easy as dragging them to your documents list if you use the Chrome browser. Google Docs 
will convert the file to Docs format for online editing if you desire; then the file won't count 
against your storage.
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